cCOO=
Introduction to Call Logging Service

COMPANION APPLICATION

INTRODUCTION TO BPO CALL LOGGING
SERVICE

(RSI_CallLogService)
Introduction

* BPO_CallLogger Service is a server based service that checks a
specified email account for emails from clients and logs calls for
emails where valid details exist

* The client contact who sends the email needs to be configured on
the customer screen as a contact.

* At least the Serial Number or Location Description need to be
noted within the email. Contract number can be included.

* An ‘Aliases’ xml file will enable a set of ‘allowed’ phrases for the
system to pick up which text in the email is related to Serials, Loca-
tions or Contracts.

* After typing in the serial no., location or contract - the email
sender will need to enter onto a new line or use a semi-colon (;)

* There should be a description regarding what needs to be done -
which will be used for the call description and the email should
have a subject.

* All emails are saved to tbIWKOREmails. Valid emails that are

logged as a call and will be marked as IsProcessed = ‘Yes'.

RSI_EmailLogViewer
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* Emails not processed can be viewed in the BPO_CallLogViewer
application - to be dealt with manually. Once logged, you can ‘Flag
and Close’ the email from the Viewing app.

* Install the EmailLogViewer on the User’s Workstation who will be

monitoring these items.

INSTALLATION

* Double click on the 'BPO_CallLogger' install file.
* Note: Check that you have the latest version.

BPO_CallLog
ger-1.0.0.1-R
elease.msi

* The Installation Wizard will open.
e Click on Next.
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Welcome to the BPOCallLogger Setup Wizard LA

The installer will quide vou through the stepz reguired toinstall BPOCallLogger on your compter.

WARMNIMG: This computer program iz protected by copenght law and international treaties.
IInauthorized duplication ar digtribution of this program, ar any partion of i, may result in sevvereicivil
or criminal penalties, and will be prosecuted to the maximum extent pozzible under the law,

Cancel % Back

1. The default location for installation is:
C:\Program Files\CO3 Technologies (Pty) Ltd\BPOCallLogger\

It is recommended that you keep this default location. Keeping a

standard will make upgrades easier.

2. Ensure that Everyone is selected for the install.
3. Click on the Next button.
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ﬁ BEPOCallLogger — o

Select Installation Folder =N

=0

T he installer will install BPOCallLogger to the fallawing folder.

Toinztall in this folder, click "Mest". Toinztall to a different folder, enter it below or click “'Browse'".

Ealder: r/-‘.

C:AProgram FileshCO3 Technologies [Pry] LtdsBPOCalLoggert, [ “Ei.r.cuwse...

Disk Cost...

Install BPOCallLogger for yourself, or for anyone who uses this computer:

ver_uu:une ‘—.

() dust me

Cancel u < Back i

1. The installer will ask you to Confirm Installation.
2. Click on Next to start the installation.
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¥ BPOCallLogger _ i

Confirm Installation 4—. v R

The installer iz ready ta inztall BPOCalLogger on your computker.

Click "Mewt" to start the ingtallation.

Cancel u < Back i

The BPOCallLogger installation will begin. Wait for it to be completed.

1. Once Installation is Complete.
2. Click on Close.
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ﬂ sHU allLogger

Installation Complete

—@

Click "Cloze" to exit.

BPOCalLogger has been successfully installed.

Flzaze uze Windows Update ta check far any critical updates to the MET Framewark.

Cancel

< Hack

Cloze

ENVIRONMENT [ SETTINGS CONFIGURATION

1. Inyour File Explorer, search for the following file location:

C:\Program Files\CO3 Technologies\BPOCallLogger

2. Right click on the Configuration.xml file.
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Home Share View
[HD L'l & Cut X EII I New item ~ u I Open = FH select all
* [ Edit

w- Copy path ﬂEasy access ¥ oo Select none
Pin to Quick Copy Paste Move Copy Delete Rename MNew Properties

access [7] Paste shartcut tor to-v 37 folder
Clipboard Organise MNew Cpen Select

{7 History EE Invert selection

« 4 1‘| < Windows (C:) » Program Files » CO3 Technologies (Pty) LTD » BPOCallLogger v bl Search BPOCallLogger

r

a Abigailm o MName Date modified Type Size

-ahdiid Log 12-12-2019 11:01 AM File folder
.dotnet E] BPO.Common.DLL 01-08-2018 3:53 PM Application exten... 4036 KB
_# 3D Objects [#5] BPO_CallLegger.exe 01-08-2018 3:53 PM Application 3974 KB
AppData | ] BPO_CallLogger.InstallState 12-12-2019 11:01 AM INSTALLSTATE File 8 KB
BusinessLogic.DLL 01-08-2018 3:53 PM Application exten... 5917 KB
| | Configurationxml ID'I -08-2018 3:46 PM XML Documnent 1KE
Datalayer.DLL 01-08-2018 3:53 PM Application exten... 5919 KB
[ Decktop _— _— .
Entities.DLL 01-08-2018 3:53 PM Application exten... 4,397 KB
“| Documents L ,. 5
SpamAddressList.tet 01-08-2018 353 PM Text Document 1KBE
& Downloads 5] SubjectExceptionPattems.txt 01-08-2018 3:53 PM Text Document 1KB

@ CO3 Technologies (Pty)Ltd
[E3 Contacts

1 Favourites
Intel ¥

10items 1 item selected 1022 bytes

1. The File menu will open.
2. Select to Edit with Notepad++.

| [ = | BPOCallLogger = [m] X
Home Share View 0
& u & cut [ x EII T New item ~ u () open ~ [ selectall
we Copy path « ﬂ Easy access ™ Edit 10 Select none
Pinto Quick Copy Paste - Move Copy Delete Rename MNew Properties . E .
access |ﬂ Paste shortcut tor to- - folder - &5 History E'F Invert selection
Clipboard Organise MNew Open Select
“ v P e Windows (C:) » Program Files » CO3 Technologies (Pty) LTD » BPOCallLogger ~ 0 Search BPOCallLogger £
a Abigailm ek Mame Date modified Type Size
-android Log 12-12-201811:01 AM  File folder
«dotnet E] BPO.Commaon.DLL 01-08-2018 3:53 PM Application exten... 4036 KB
_ 3D Objects [#5] BPO_CallLogger.exe 01-08-2018 3:33 PM Application 3974 KB
AppData [ BPO_CallLoggerInstallState 12-12-201911:01 AM INSTALLSTATE File KB
@ C03 Technologies (Py)Ltd B BusinessLogic.DLL 01-08-2018 3:53 PM Application exten... 5917 KB
[ Contacts D Configurationaxml TKB
onta Open
Dectt |4 Datalayer.DLL e 5,919 KB
I Desktop [5] Entities.DLL : } 439TKB
i . Edit with Microsoft Expression Web 4
SpamAddresslist bt e 5 TKB
-7ij
& Downloads SubjectExceptionPatterns tet = £ 1KB
" - II!f Edit with Notepad++ I
iy Favourites
= E Scan with Windows Defender:'\'
foiel |2 Share
& Links Open with >
MicioeoRtdgerackuis Restore previous versions
Music
J’ Send to &3
#@ OneDrive
OneDrive for Business - Unsyr , s
Co
10items 1 item selected 1022 bytes i

The xml file will open in Notepad++.
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Type in the Environment, Database and Email Settings:

1. Environment: Type in the environment name, as defined for this data-
base, in the Service Manager.
2. Default Customer Code: Type in the Default Customer Code details.
3. Select Yes to Process the selected environment.
4. The Email settings need to be configured:
e Call Email Server: Type in your company's Call Email
Server details.
e Call Email Port: Type in your company's Call Email Port
details.
* Call Email User Name: Type in your company's Call Email
User Name details.
e Call Email Password: Type in your company's Call Email
Password details
* Call Email EnableSsl: Type in Yes.
* Encrypted: Type in No.

SERVICE CONFIGURATION

5. Interval Amount Type in the time interval amount for this service to
rune.g. 2, 10, 60.
Interval Unit Type in the time unit the interval amount e.g. min
(minutes), hrs (hours) day (days).

* In this example, the service will run once every 10 seconds.

6. When you have finished editing this file, click on Save.
7. Close Notepad++
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H *C:\Program Files\CQ3 Technologies (Pty) LTDABPO CallLogger\Configuration.xml - Notepad++

File Edit Enceding Language Settings Tools Macre Run  Plugine Window 7

@@ Slsmblocing 2 BE =1 Eles | il B
.mnmm IECcnﬁguraticnm'nlEﬂI

1 <%?xml version="1.0" encoding="utf-8" standalone="yes"?>

= <NewDataSet>

3 g <tblTimerSettings>

4 <IntervalBmount>10</Intervalfmount>

5 <!-—IntervalUnit can be hr/min/sec——> ‘—.

6 <IntervalUnit>sec</IntervalUnit>

i) - </tblTimerSettings>

8 [H <tblEnvironments>

S E <l-— Bervice Manager Environment

10 name ('HEEY LOCAL MACHINE\SOFTWARE\CO3\BPC RSI\Services'

It - or "HEEY LOCAL MACHINE\SOFTWARE\Wow&432Node\CO3\BPO _R3T\Services'-->

12 <EnvironmentiBPO2 ALPHAl ,-"Environment><—6

13 <DefaultCustomerCods /DefaultCustomerCode>

14 = <!-—¥Yes or Mo to indicate i1f the environment must be included

15 - or excluded from the processing.-—->

16 <Process /Process>

17 <!-— call email account settings ——>

18 <CallEmailServer>pop.gmail.com</CallEmailServer>

19 <CallEmailPort>995</CallEmailPort>

20 <CallEmailUsernams>userfdomain.co.za</CallEmailUssrnams> . .

23 “<CallEmailPassword>pAssWord</CallEmailPassword>

22 <CallEmailEnableSsl>yes</CallEmailEnableSsl>

23 <Encrypted>No</Encrypted>

24 I </tblEnvironments>

25 L</NewDataSet>
< >
eXtensible length: 1,028 lines: 25 Ln:15 Col:5 Sel: 0|0 ‘Windows (CR LF) UTF-8-BOM IMS

ALIAS CONFIGURATION

e An ‘Aliases’ xml file will enable a set of ‘allowed’ phrases for the
system to pick up which text in the email is related to Serials, Loca-

tions or Contracts.
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7 e - Netepad - 0 X
Fie fdt Formmt View Help

<#uml versions"1.0" encoding="utf-8" B A
Hewdatadets
¢herdalhliasy
¢Al{asyheriale ¢/Allas>
¢fSerfaldliasy
SerfalAlian
<Alfasserfal = ¢/Alfan
¢/Serfaldliasy
¢Serialaliasy
<hliasyserial =¢/Aliasy
¢f5erialdliasy
cSerialiliasy
¢hliasySerial=¢ /dliasy
¢fSerialiliasy
¢Serdaliliasy
¢hlfasyberial: ¢/Aliash
¢fSerialdlias:
cSerfalAlian
lfaserial : ¢/Alfas>
¢/Serfaldlias
cSerfalAlian
<AliassSerial ;¢/Aliasy
f5erialdliasy
¢Serialiliasy
¢hliasyserial;¢/hliasy
¢fSerialiliasy
Serdaliliasy
¢hl1asySh= ¢/h11ass
¢fSerialdliasy
¢Sarfaliliasy
AldasySH = </ALLasy
¢fserlaldlias
Serfalalias
Aliassh we/Alias
¢fSerialdliasy
cSerialaliasy

START SERVICE

Once you have done the service configuration, you need to start the service

from the Administrative Tools > Services screen in Windows.
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e Select the Windows icon in your taskbar.

1. Search for and single click on Windows Administrative Tools.
The Tools menu will expand.

2. Search for and single click on Services.

. Windows Accessories

B Windows Administrative Tools

Component Services 0 E H
-

g Computer Management Visual Studio
Outlock File Explorer 2017

_‘: Defragment and Optimise Drives

Disk Clean-up e P gl E

Microsoft
Skype Greenshot Publisher Expressian...

Event Viewer

5 Intemnet Information Services (11S)...
" Life at a glance
Bl Intermnet Information Services (115)...

1_, iSCSI Initiator
-

SQL Server i HP Client

Management..  Server.. Security

s Local Security Policy

8 ODBC Data Sous
Areale
™ ODBC Data Sources (64-bit) SHOEM

9

Photos Google Chrome

)} Performance Monitor
Print Management
Recovery Drive

i Registry Editor

)} Resource Monitor
Services
System Configuration

vstem |nformation

1. The Services screen will open.
2. Right click on BPO CallLogger Service.
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3. In the pop-up menu, click on Properties.

&—

apability Access Manager Service
aptureService_b358d1b
£ Cellular Time
£} Certificate Propagation
& Client License Service [ClipSWi
i@, Clipboard User Service_b358d1b
) CNG Key lsolation

i COM+ Event System

£ COM+ System Application

i ster Bensrar

<

Start

conte.
Stop ging U
Pause ture fu
Resume an MIT.
Restart root ce...
ort for ...
Al Tasks Clipbo.
\ Refresh ceis how.
ificatio. ..
and tra...
Help i

Running

Running
Running
Running
Running
Running

Biummine

Automatic

Manual

Manual

Manual

Manual (Trigger Start)
Manual (Trigger Start)
Manual (Trigger Start)
Manual

Manual (Trigger Start)
Automatic

Manual

Rtsriial (Trimmar Shart)

- a x
File Action View Help
= |EHEcZ BE renwn
(. Services (Local) % kil N
- ~
BPO CallLogger Service Name Description Status Startup Type LogOna ™
:.Q;AsslgnadAccEssManagEr Service  AssignedAccessManager Services... Manual (Trigger Start) Local Sys
Start the service &
;};Auto Time Zone Updater Automatically sets the system time... Disabled Local Ser.
G VCTP service This is Audio Video Control Transp... Running  Manual (Trigger Start) Local Ser
Description: £} Background Intelligent Transfer S... Transfers files in the background u... Running  Automatic (Delayed Start)  Local Sys
A server based service that checks £ Background Tasks Infrastructure ... Windows infrastructure servicetha.. Running  Automatic Local Sys
specified POP3 email accounts for -f:) Base Filt E The Base Filt E D R A —
emails from clients to log BPO service ¢ .ase i erm.g ngine ) ) e Base Filtering Engine .|s a.. Running utomaf |c. ocal Ser
calls. £ BitLocker Drive Encryption Service  BDESVC hosts the BitLocker Drive E... Manual (Trigger Start) Local Sys
lock Level Backup Engine Service  The WBENGIME cervice is used by ... Manual Local Sys
£} Bluetooth Audio Gateway Service  Service supparting the audio gate..  Running  Manual (Trigger Start) Local Ser
£} Bluetooth Support Service The Bluetooth service supports dis..  Running  Manual (Trigger Start) Local Ser
E:’, Bluetooth User Support Service_...  The Bluetooth user service support... Manual (Trigger Start) Local Sys
£k Bonjour Service Enables hardware devices and soft... Running Automatic Local Sys

Local Sy:
Network
Local Sys
Local Sys
Local Ser
Local Sys
Local Sys
Local Sys
Local Sys
Local Ser
Local Sys

1 nral Sue

Extended /(Standard /

1.
2.
3.

4.

* This setting will ensure the service is restarted if your server

is restarted.

Click on OK.

The Properties screen will pop up.
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BPO CallLogger Service Properties (Local Computer) 4—. X

General LogOn  Recovery Dependencies

Service name: BPOCallLoggerService

Dizplay name: BPO CallLogger Service

gerver based service that checks specified POP3
ail accounts for emails from clients to log BPO

arvira ~alle

Description:

Path to execitable:
"C:\Program Files\C03 Technologies (Pty) Lid"\BPOCalLogger BPO_Ce

Startup type:

—I Manual

] Disabled
Service status:  STOppeEd

| Start | Stop Pause Resume

You can specily the start parameters that apply when you start the service
from here.

Start parameters: |

.—> [ ok ||| camcel || ey

The Properties menu will disappear.

1. Inthe Services screen, you will note that the service Startup Type has
now changed to Automatic (Delayed Start).

2. Right click on BPO Auto Close Call Service.

3. In the pop up menu, click on Start.
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4 Services - O x
File Action View Help
ez |FEEZ BRl »enmn
Services (Local) T Serces ftocal
BPO CallLogger Service Name ? Description Status Startup Type LogOn A ™
Rf:);AsslgnedAccessManager Service  AssignedAccessManager Service 5. Manual (Trigger Start) Local Sys.
L L 18} Auto Time Zone Updater Automatically sets the system time... Disabled Local Ser
Eh AVCTP service This is Audio Video Contral Transp... Running  Manual (Trigger Start) Local Ser
Description: ;E:@;Backgmund Intelligent Transfer S... Transfers files in the background u..  Running Automatic (Delayed Start) Local Sys
A server based service that checks £ Background Tasks Infrastructure ... Windows infrastructure servicetha.. Running  Automatic Local Sys
ZF:aci‘rs‘effDTEﬁ;"&at":‘g?é‘p"g::'r’w(e I-.f:)_,BasE Filtering Engine The Base Filtering Engine (BFE} isa .. Running  Automatic Local Ser
calle: BitLocker Drive Encryption Service BDESVC hosts the BitLocker Drive E... Manual (Trigger Start) Local Sys
5} Block Level Backup Engine Service  The WBENGIME service is used by ... Manual Local Sys
'{:{-Bluatooth Audio Gateway Service  Service supporting the audio gate..  Running Manual (Trigger Start) Local Ser
&k Bluetooth Support Service The Bluetooth service supports dis...  Running  Manual (Trigger Start) Local Ser
The Bluetooth user service support. Manual (Trigger Start) Local Sys
Enables hardware devices and soft..  Running Local Sys
e—» Local Sy
T Network
c gingU.. Running  Manual Local Sys
s ture fu, Manual Local Sys
), Cellular Time Reme on NIT. Manual (Trigger Start) Local Ser
£} Certificate Propagation Restart raotce.. Running  Manual (Trigger Start) Local Sys
;i)ﬁ lient License Service (ClipSVC) Al Tasks 5 |portfor.. Running Manual (Trigger Start) Local Sys
5} Clipboard User Service_b358d1b Clipbo..  Running Manual Local Sys
£} CNG Key Isolation Refresh ceisho.. Running  Manual (Trigger Start) Local Sys
£} COM+ Event System = ficatio.. Running  Automatic Local Ser
£, COM=+ System Application bropertics and tra... Manual Local Sys
':'a.rm.w.m,nw.“. Help §rmmn  Ruemine bamoal Tianer Ghasl 1mral Gue
Extended £ Standard //
1. The service will now be Running.
2. Close the Services screen.
ces — [m]
File Action View Help e/"
NG IEEE I D
. Services (Local) o Wl’-ﬂﬁﬂ
BPO CallLogger Service Name - Description Status Startup Type LogOna ™
& AssignedAccessManager Service  AssignedAccessManager Service . Manuzl (Trigger Start) Local Sys
%:i;r: :hs:::vei(e Q;Auto'ﬁme Zone Updater Automatically sets the system time... Disabled Local Ser,
S 5 AVCTP service This is Audio Video Contral Transp.. Running  Manual (Trigger Start) Local Ser
£ Background Intelligent Transfer S... Transfers files in the background u... Running  Automatic (Delayed Start)  Local Sys
Description: -\.‘.‘-;);Eackground Tasks Infrastructure ... Windows infrastructure service tha...  Running Automatic Local Sys
':pz:‘f":db;éidgs:nr:‘a?ls;::sj:;(f‘; \f:«“ Base Filtering Engine The Base Filtering Engine (BFE} isa .. Running Automatic Local Ser
emails from clients to log BPO service : Bitlocker Drive Encryption Service  BDESVC hosts the BitLocker Drive E... Manusl (Trigger Start) Local Sys
calls. lack Level Backup Engine Service  The WBENGINE service is used by .. Manual Local Sys
&’:&Eluetooth Audic Gateway Service  Service supporting the audic gate..  Running Manual (Trigger Start) Local Ser
‘{';:};EIuetDDth Support Service The Bluetooth service supports dis..  Running Manual (Trigger Start) Local Ser
£ Bluetaath User Support Service ..  The Bluetoath user service support... Manual (Trigger Start) Local Sys
£ Bonjour Service Enables hardware devices and soft.. Running  Automatic Local Sys
&; BPO CallLogger Service A server based service that checks .. Automatic (Delayed Start) Local Sys
s BranchCache This service caches network conte.. Manual Network
& Capability Access Manager Service Pravides facilities for managing U..  Runring  Manual Local Sys
£ CaptureService_b352d1b Enables optional screen capture fu... Manual Local Sys
C}Cellu\ar'ﬁme This service sets time based on NIT... Manual (Trigger Start) Local Ser
£ Certificate Propagation Copies user certificates and root ce.. Running  Manual (Trigger Start) Local Sys
{52 Client License Service (ClipSVC)  Provides infrastructure support for .. Running  Manual (Trigger Start) Local Sys
&2 Clipboard User Service_b3528d1b  This user service is used for Clipbo...  Running  Manual Local Sys
\.‘.‘:);CNG Key Isolation The CNG key isolation service is ho...  Running Manual (Trigger Start) Local Sys.
15 COM+ Event System Supports System Event Notificatio.. Running  Automatic Local Ser
£ COM+ System Application Manages the configuration and tra... Manual Local Sys
B Cnrnibar Rracar Maintsine an iinnston lick nf camn_ Bunnina _ Manial fTrinaar Skar) | nral G ¥
<
Extended /(Standard/

CAP.005.001
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